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CONSIDERAÇÕES INICIAIS 
 
A execução de tarefas concomitantes e o engajamento de processos 
atencionais nestas tarefas é um fenômeno que tem sido bastante estudado em 
psicologia cognitiva. Existe certo consenso de que, como resultado do treino, 
algumas atividades de processamento deixam de ser voluntárias e tornam-se 
automáticas. Nestes casos, o treino exerce influencia no desempenho das 
tarefas e faz com que menos atenção seja necessária para executá-las. Por 
exemplo, uma pessoa treinada é capaz de dirigir e ao mesmo tempo conversar 
com o passageiro ao lado sem que precise empregar certa atenção aos 
controles do carro (embora ainda precise estar atenta ao trânsito!).  
 
De modo geral, alguns critérios foram estabelecidos para se caracterizar os 
processos automáticos: 
  

1. Processos automáticos são rápidos e não necessitam de atenção; 
2. Processos automáticos não reduzem o desempenho em tarefas 

concomitantes que exigem atenção; 
3. Processos automáticos são inevitáveis (eles sempre ocorrem 

quando na presença de estímulo específico, mesmo que este 
estímulo não seja atendido). 

 
Em termos experimentais, é difícil satisfazer os critérios acima. Por exemplo, 
mesmo o Teste de Stroop (Stroop, 1935), que tem sido empregado na 
avaliação do desempenho concomitante em duas tarefas conflitantes (nomear 
as cores ao invés das palavras), não satisfaz completamente o critério de 
inevitabilidade. Neste caso, a interferência automática e inevitável das palavras 
sobre as cores pode ser modulada pela posição do estimulo distraidor 
(palavra): quanto mais próximo da cor mais interferência ela causa (Kahneman 
& Henik, 1979). Isso mostra que nem sempre a resposta ao estímulo que é 
processado automaticamente é inevitável.  
 
Por sua vez, uma distinção evidente entre os processos automáticos e os 
processos voluntários (ou controlados) pode ser estabelecida da seguinte 
forma (Shiffrin & Scheneider, 1977): 
 

1. Processos voluntários têm capacidade limitada, são lentos, 
necessitam de atenção e podem ser utilizados de forma flexível 
(1) em diferentes contextos; os estímulos são processados 
serialmente (um de cada vez); 

2. Processos automáticos não sofrem de limitações da capacidade 
de processamento, são rápidos, não precisam de atenção e são 
muito difíceis de modificar uma vez aprendidos; os estímulos são 
processados em paralelo (vários ao mesmo tempo). 



 
(1) podem facilmente ser alterados se a contingência entre estimulo e resposta 
for modificada, isto é, se a maneira com que a tarefa era anteriormente 
executada tornar-se inadequada. Veja aula prática que evidencia este aspecto 
em http://www.alessandrofazolo.com/didatico/aulas/praticas/pratica3_atencao.pdf . 
 
Tendo em mente estes conceitos podemos pensar nos experimentos que serão 
usados em nossa aula prática. Para tanto iremos utilizar um software bem útil: 
o StimScope. 
 
O StimScope é um software configurável que apresenta sequencialmente na 
tela dois estímulos. Este programa pode registrar respostas e o tempo de 
emissão das mesmas. É um programa muito útil para se criar tarefas de 
discriminação nas quais o sujeito deve responder após a apresentação 
consecutiva de dois estímulos (delayed matching tasks) e apresenta a 
vantagem de possibilitar a configuração de vários aspectos do experimento, 
inclusive os estímulos a serem utilizados. Devido à raridade de bons programas 
gratuitos para experimentos em psicologia cognitiva na Web, pensei em usar 
os StimScope para criar experimentos que medem o processamento 
automático e o processamento atencional voluntário.  
 
O roteiro a seguir descreve a elaboração de uma aula prática que pode ser 
produtiva para alunos da disciplina de Processos Psicológicos Básicos do 
curso de Psicologia.  
 
Obs.:  Esta aula pode ser feita utilizando-se outro software. Veja mais detalhes 
em 
http://www.alessandrofazolo.com/didatico/aulas/praticas/pratica2_atencao.pdf 
 
 
ETAPAS INICIAIS 
 

1. Baixe e instale o software StimScope  no link abaixo: 
http://www.rzoont.dds.nl/stimscope/Downloads/downloads.html 
 

2. Crie uma série variada de figuras contendo no centro uma seqüência 
aleatória de 1 a 4 consoantes e/ou números não repetidos. Por exemplo: 
QTRY, WDF, 45R, 5467, 567P, R, 5... Estas figuras serão nossos 
estímulos (você pode usar programas gráficos como o CorewDraw e o 
Adobe Illustrator ou até mesmo o utilitário Paint do Windows). 

3. As seqüências podem conter somente consoantes, somente números ou 
serem alfanuméricas (letras e números). No entanto, algumas das 
seqüências alfanuméricas devem incluir apenas uma letra e o restante 
de números. As consoantes devem ser MAIÚSCULAS. 

4. Crie cerca de 60 seqüências e procure não variar muito as letras. Será 
necessário que haja diferentes seqüências com a mesma consoante em 
muitos dos estímulos (mas não todos). 

5. As imagens devem ter no máximo 300X300 de tamanho e devem ser 
idênticas uma das outras exceto, é claro, pela seqüência de consoantes 
e números no centro. 



6. Salve as figuras no formato bitmap (*.bmp) na pasta “Stim” do diretório 
que o Windows instalou o StimScope (provavelmente em C:\Arquivos de 
programas\Stimscope). O nome dos arquivos deve ser a seqüência de 
caracteres que eles contêm para facilitar sua identificação. 

7. Configurações básicas: 
a. Inicie o StimScope. Configure as teclas a serem usadas como 

respostas aos estímulos. Para isso, clique em Settings > 
Responses > Keyboard. Posicione o cursor no campo Key #1 e 
tecle “A”.  Posicione o cursor no campo Key #2 e tecle “Ç”. O 
programa estabelece números para cada tecla. Clique em “OK”. 
Neste caso, as teclas “A” e “Ç” serão cada qual uma das 
respostas esperadas no experimento e deverão ser usadas pelo 
sujeito do experimento, dependendo do estimulo apresentado. 
Note que as teclas escolhidas poderão ser outras.  No entanto, 
não utilize teclas muito próximas ou que deverão ser 
pressionadas pela mesma mão.  

b. Configure o modo de exibição para que o experimento ocupe a 
toda tela. Clique em Settings > Screen > Full Screen mode. 

c. Configure os tempos limites (em mseg) do experimento (as 
configurações padrões poderão ser mantidas, neste caso pule 
esta etapa). No StimScope, clique em Seetings > Timings e 
configure os seguintes valores segundo a sua preferência: 

i. ITI: Intervalo entre um teste e outro. 
ii. FIX: Quanto tempo a imagem de fixação (+) que marca o 

início de cada teste irá aparecer na tela. 
iii. ISI-1: Tempo entre a imagem de fixação e o primeiro 

estímulo (S1). 
iv. S1: Tempo de permanência do primeiro estímulo. 
v. ISI-2: Tempo entre o primeiro e o segundo estímulos (S1 e 

S2). 
vi. S2: Tempo de permanência do segundo estímulo. 
vii. Timeout: Intervalo no qual o sujeito pode emitir uma 

resposta. Começa em S2.  
 

 
CRIANDO UM EXPERIMENTO PARA ANALISE DO PROCESSAMENTO 
AUTOMÁTICO 

 
1. Agora iremos criar um experimento para avaliar o Processamento 

Automático . Para o tipo de resultado que estamos buscando neste 
experimento teremos que produzir uma tarefa na qual os sujeitos 
terão inicialmente que memorizar uma seqüência de letras (chamada 
de conjunto de memória) e verificar logo após se uma das letras 
apresentadas anteriormente aparece numa segunda seqüência 
(conjunto visual). Para o caso de avaliarmos o processamento 
automático usaremos um padrão de estímulos conhecido por 
“Mapeamento Consistente” (Shiffrin & Scheneider, 1977) onde só 
letras serão usadas no conjunto de memória e uma seqüência que 
pode conter letras e números será usada no conjunto visual.  

 



2. Abra o utilitário “Block Editor” (Tools > Block Editor) do StimScope. 
Note que as figuras que você criou anteriormente estão listadas nos 
campos “First Stimulus (S1)” e “Second Stimulus (S2)”. “First 
Stimulus (S1)” representará nosso conjunto de memória e “Second 
Stimulus (S2)” representará nosso conjunto visual. 

 
3. Siga estas etapas: 

a. No campo “First Stimulus (S1)” escolha uma figura cuja 
seqüência contenha apenas letras.  

b. No campo “Second Stimulus (S2)” escolha uma seqüência que 
contenha letras e números e que a letra seja uma das que 
aparecem na primeira seqüência.  

c. No campo “Expected Key”, escolha “1” (será a tecla 
correspondente à Key #1, no caso “A”). Deixe desmarcada a 
opção “Auto Expected” e marcada a opção “Auto TrialName”. 

d. Preencha o campo “Condition” com a quantidade de 
caracteres de cada seqüência, da seguinte forma: S1-S2-
CONS. Assim, se S1=RTYP e S2=45T, o campo “Condition” 
deverá ser 4-3-CONS. CONS é de "consistente". O campo 
“Condition” é opcional. Mas neste caso será necessário 
preenchê-lo com as variáveis de cada estímulo para facilitar a 
análise dos resultados posteriormente.  

e. Clique em “Add”.  
 

4. Note que uma linha representando o primeiro teste comparativo do 
experimento foi incluída. Repita a etapa anterior até que você tenha 
em torno de 30 a 50 testes comparativos (linhas) compondo o 
experimento. Evite ultrapassar estes limites, pois poucos testes 
podem dar resultados inconsistentes e muitos testes podem tornar o 
experimento cansativo para os sujeitos.  

 
OBS. IMPORTANTE:  “1” será sempre a “Expected Key” caso o conjunto visual 
(S2) contenha uma dos caracteres do conjunto de memória (S1). Chamaremos 
estes testes de positivos. Caso o conjunto visual (S2) não apresente nenhum 
dos caracteres do conjunto de memória (S1) a “Expected Key” deverá ser “2” (a 
tecla correspondente à Key #2, no caso “Ç”). Chamaremos estes testes de 
negativos. Lembre-se, neste caso estamos construindo uma tarefa do tipo 
“mapeamento consistente” e as seqüências de S1 sempre deverão ser 
composta por letras. As seqüências em S2 que pedirem o acionamento da 
tecla “2” (Ç), os chamados testes negativos, deverão conter somente números 
e nenhuma letra. Em outros termos, apenas letras deverão ser usadas como 
itens do conjunto de memória, e apenas números deverão ser usados como 
elementos distraidores do conjunto visual. Assim, se o sujeito vir apenas letras 
para memorizar, então ele “saberá” que qualquer letra detectada no conjunto 
visual teria que ser um dos itens apresentados no conjunto de memória.  
 
 

5. Não se esqueça de variar ao máximo possível os seguintes critérios 
dos testes: 

a. Tipo de testes comparativos; negativos ou positivos; 



b. Tamanho das seqüências, 1, 2, 3 e 4 caracteres, tanto do 
conjunto de memória quanto do conjunto visual. 

 
Obs.: você poderá ainda programar uma randomização automática dos 

testes comparativos em Seetings > Trials > Randomize Trials) 
 

6. Ao terminar salve seu experimento na pasta “Blocks” do diretório 
“Stimscope” (File > Save as...). Dê o nome de “mapeamento 
consistente” ao arquivo. 

 
CRIANDO UM EXPERIMENTO PARA ANALISE DO PROCESSAMENTO 
ATENCIONAL VOLUNTÁRIO 
 

1. Siga todas as etapas descritas anteriormente.  
2. Na etapa 3 acima considere o seguinte: para avaliar o Processamento 

Atencional Voluntário iremos utilizar uma tarefa do tipo “Mapeamento 
Variável”, descrito por Shiffrin & Scheneider (1977), onde os estímulos 
usados tanto do conjunto de memória quanto do conjunto visual, 
poderão ser compostos de seqüências que misturam números e letras 
em proporções variadas.  O campo "Condition" deve ser preenchido da 
seguinte forma: S1-S2-VAR. S1, tamanho da seqüência do conjunto e 
memória; S2, tamanho da seqüência do conjunto visual; VAR de 
"variável". Estas são as únicas diferenças entre as tarefas de 
mapeamento consistente e mapeamento variável. Siga o restante do 
procedimento acima. 

3. Salve o arquivo na pasta “Blocks” com o nome de “mapeamento 
variável”. 

 
OBS. Pode-se ainda criar um único experimento que misture testes do tipo 
mapeamento consistente com testes do tipo mapeamento variável de modo 
alternado. Mas, para fins didáticos é aconselhável manter os dois tipos de 
mapeamento em experimentos diferentes. 
 
REALIZANDO OS EXPERIMENTOS EM SALA DE AULA 
 

1. Inicie o StimScope nos computadores; 
2. Clique em File > Open... (Ctrl + O) e navegue até a pasta “Blocks”. Abra 

o arquivo “mapeamento consistente” ou “mapeamento variável” salvos 
anteriormente; 

3. Clique em “Ctrl + S” e depois em “OK”; 
4. A partir de agora o programa estará pronto para iniciar o experimento. 

Cuide para que os computadores fiquem assim até a hora de começar. 
5. Divida a turma em grupos de 5 pessoas e distribua os grupos nos 

computadores. O total e o tamanho dos grupos irão depender da 
quantidade de alunos e da quantidade de computadores disponíveis; 

6. Explique para toda a turma o procedimento a ser realizado na tarefa 
experimental, enfatizando os seguintes pontos: 

“Um aluno de cada grupo servirá como sujeito experimental, devendo 
realizar o teste, enquanto os demais membros deverão ficar em 
silêncio para não atrapalhar. O experimento será composto de 30 



testes comparativos nos quais o sujeito verá seguidamente na tela 
duas seqüências composta cada qual de letras e/ou números. Ele 
deverá memorizar a primeira seqüência e decidir o mais rapidamente 
possível se algum dos caracteres que apareceram na primeira 
seqüência é igual a qualquer um dos caracteres da segunda 
seqüência. Caso for igual ele deve pressionar a tecla “A” e caso não 
for igual ele deve pressionar a tecla “Ç”. Durante todo o experimento 
aparecerá, ao centro da tela, uma imagem de fixação representada 
pelo sinal de “+” que marcará o início de cada teste comparativo. 
Logo após aparecerá uma seqüência (a ser memorizada), seguida de 
outra seqüência (a ser comparada). Somente após aparecer a 
segunda seqüência uma das teclas deverá ser pressionada. Faça 
isso o mais rapidamente possível e para todos os testes 
comparativos, até o experimento terminar. Alguma dúvida?” 

 
7. Com cada sujeito pronto, peça a cada um deles para pressionar a tecla 

“F12” para começar. Aguarde até que o último aluno termine seu 
experimento. Ao termino do experimento peça aos sujeitos para clicarem 
em “OK” e pressionarem novamente “F12”. 

8. Terminado o experimento, abra os resultados. Para isso devemos clicar 
em Tools > Inspect data (Ctrl + D). Surgirá uma tabela com os valores 
de cada teste comparativo: qual era a “Expected key” de cada teste e 
qual foi a tecla pressionada pelo sujeito, qual foi o tempo gasto para se 
pressionar a tecla, o tempo limite para cada decisão, entre outras 
informações. 

9. Salve os resultados como arquivo “*.csv” na pasta “Data” do diretório 
“Stimscope”.  

10. O arquivo poderá então ser aberto no Microsoft Excel© para a criação de 
gráficos e tabelas. Serão de nosso interesse por hora os valores 
contidos nas seguintes colunas: S1 (primeira seqüência), S2 (segunda 
seqüência), Expected (tecla que deveria ser pressionada), Conditn 
(tamanho de cada seqüência e tipo de mapeamento), Response (tecla 
pressionada), RT (tempo que o sujeito levou para responder) e Timeout 
(tempo limite para a resposta).  

11. Os alunos deverão construir a avaliar gráficos com as seguintes 
variáveis: 

a. Tipos de testes: negativos e positivos; 
b. A quantidade de erros; 
c. O tempo de emissão das respostas corretas; 
d. Tamanho do conjunto de memória e do conjunto visual (2).  
e. Comparar os resultados obtidos no experimento de mapeamento 

consistente e no experimento de mapeamento variável. 
 
(2) Para efeito comparativo consideraremos apenas os valores extremos. 
Assim, seqüências de 1 e 2 caracteres serão classificadas com valor “1” e 
seqüências de 3 e 4 caracteres serão classificadas com valor “4”. 
 
 



12. Os resultados deverão ser discutidos em sala de aula considerando os 
aspectos teóricos relacionados com cada tipo de processamento 
atencional envolvido na tarefa experimental. 
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